Suite philosophy
streamlines web design

BY PETER DUDAR

| RECALL A RECENT TRADE SHOW IN WHICH
Macromedia offered Dreamweaver,
Fireworks and Flash as a comprehen-
sive Web suite: Dreamweaver for au-
thoring Web pages, Fireworks for mak-
ing and producing Web graphics, and
Flash for creating high-end animation
and interactivity.

Until now, constructing and updat-
ing a website has required going in and
out of disparate applications, including
text editors, vector-based graphics pro-
grams, image editors, animation tools

and Debabelizer-type processing
and optimization utilities. Macro-
media is in the vanguard of soft-
ware developers streamlining
that process.

Proviso: recommended RAM alloca-
tions for these applications range any-
where from 16 to 40 MB each, depend-
ing on the system used (Windows,
Windows NT, Mac PowerPC).

DREAMWEAVER 1.2

Dreamweaver premiered as the first
WYSIWYG Web authoring tool with
support for dynamic HTML, including

AT HOME WITH THE HOMEGURRRL

Lynda Weinman opens Ojai Digital Arts Center

FOR THOSE FRUSTRATED BY THE LEARNING CURVES ASSOCIATED
with mastering new web design applications, take note
that best-selling author, lecturer, journalist and instructor
Lynda Weinman (familiar to GRAPHIC EXCHANGE readers as
the Homegurrrl) has just signed a contract with Macrome-
dia to produce a series of training videos to accompany

the company'’s suite of applications.

The first video will be on Macromedia’s new Fireworks

software (reviewed in this issue).

But for serious web design folks, a more significant an-
nouncement was the September 14th opening of the Ojai
Digital Arts Center in Ojai, California, a small tourist town
located close to Santa Barbara and Los Angeles. ODAC is
a brand new training facility operated by Lynda and hus-
band/partner Bruce Heavin (check www.digitalartscenter.com for
course registration details). The new school offers in-depth
hands-on instruction by Lynda and Bruce on the full range
of design applications, including Macromedia Fireworks,
Flash, Dreamweaver, Freehand and Director; Adobe After

Effects, ImageReady, Photoshop, Premiere and Illustrator; cations.

Equilibrium Debabelizer; and GoLive CyberStudio.

Despite the fact that the school’s official pre-publicity
was only carried in a single low key press release in late
July, Lynda received a wave of response, not just from all

over North America but also from interested parties in Eu-

rope and the Middle East. Even before the doors opened,
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But when Lynda talks
about the art of teaching
in a classroom environ-
ment, her enthusiasm is

CONTINUED ON PAGE 18
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layers, style sheets, timelines and be-

haviours. (See the February 1988 issue

for a review of Version 1.0.)
Dreamweaver’s award-winning fea-

close to forty students had registered for Lynda’s week-
long immersion tutorials — a testament to her lofty stand-
ing in the web design community.

Although Lynda has achieved international status in the
world of web design through her six books on the subject
(at last count, her first book, <DESIGNING WEB GRAPHICS>
had sold better than 70,000 copies in six languages), it
was her first love — teaching — that inspired her to open
the Ojai Digital Arts Center.

Her initiation into instruction in new media came in
1989 when she began teaching Macromedia Director at
Art Center College of Design in Pasadena, California. Since
then, her open-minded dedication to dispersing knowl-
edge has propelled her to the forefront of the web design
industry. She is in demand
as a speaker at major
trade shows, as well as
being a columnist for sev-
eral major industry publi-

The announcement of the
opening of the Ojai Digital
Arts Center in Ojai, California
was met with a wave of
enquiries from all over the
world. Web design author
and instructor Lynda
Weinman (left) and Bruce
Heavin opened the doors to
their new training facility on
September 14th.

(inset) A classroom of 20
seats equipped with fully
loaded IMacs which are
networked and connected to
the Internet through a T1 line.

USING ALL THREE

As you become familiar with the
applications and clue in to their unique
strengths and capabilities, you can
more fully exploit them interchange-
ably. Macromedia’s website (www.mac-
romedia.com/support/flash/ts/nav)
provides a case study that uses the
three applications: an image is sliced

in Fireworks, it’s turned into a relatively
sophisticated animation in Flash, and
then it’s embedded into a
Dreamweaver page.

OFFLINE AND ONLINE HELP
The manuals for all three applications
are similarly designed and concise,
ranging from 134 to 200 pages.

And each provides well-indexed online
help. Dreamweaver and Flash employ
Web browsers, which include
animated tutorials, and enable you to
access current information directly
from Macromedia. Flash also provides
fully interactive lessons.

ture is roundtrip HTML, which lets you
move instantaneously between the vi-
sual window and a text editor with lit-
tle or no impact on source code; plus
integration with external text editors
such as BBEdit or HomeSite. Dream-
weaver’s roundtrip capability has not
been duplicated.

Dreamweaver enables you to set up
pages with more established means like
tables and frames, using fast click-and-
drag procedures. When you split a
page, Dreamweaver creates a frameset
file and documents for the new frames;
and you can work directly in the frame-
set display.

Dreamweaver’s Site window trans-
fers files between your local and re-
mote sites, maintaining identical direc-
tory structures to ensure that links and
references are not accidently broken. In
version 1.2, users working behind a
firewall can access site FTP features by
providing the address of the proxy
server and the port which connects to
the FTP server.

Making up
for the applica-
tion’s major
shortcoming, the
new Link Check-
er dialog gener-

ates reports of
broken links, ex-
ternal links, and
orphaned files.
You can fix broken
links and image
references directly
in the dialog by in-
putting the correct
path, or just brows-
ing to the required
file. Dreamweaver in-
forms you if there are
other broken refer-
ences to this same
file, and a simple click
updates all the docu-
ments that reference
this file.

Dreamweaver’'s new

‘Convert to 3.0 Browser’
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(top) The ‘Convert to 3.0 Browser’ command
enables you to convert DHTML pages into
pages compatible with 3.0 browsers.

(bottom) The ‘Check Browser’ dialogue. This
behavior automatically sends viewers to the
page optimized for their particular browser.

command enables you to generate alter-
nate pages compatible with 3.0
browsers, after designing pages using
layers and cascading style sheets. The
catch is, all your page content has to be
on layers, or the converter will not
work. The command converts layers
into tables, but tends to output superflu-
ous cells and occasional idiosyncrasies
while doing so. It's faster than creating
alternative pages from scratch, but antic-
ipate doing some minor fixes.

Dreamweaver 1.2 also includes a
‘Check Browser’ behavior to automati-
cally send viewers to the page opti-
mized for their particular browser. With
the new ‘Pre-load Images’ behaviour,
you can require that dependent files be
downloaded before loading the page or
executing Java-Script. Interactive prop-
erties, like a ‘Drag Layer’ feature and a
Graphical Resize feature, enable end
users to manipulate elements di-
rectly on the browser page.

Dreamweaver, which comes with ei-
ther BBEdit or HomeSite, lets you con-
figure any text editor from the prefer-
ences dialog box. With BBEdit, changes
are dynamically mirrored in the layout
and text windows.

CONTINUED ON PAGE 48
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Verging on convergence

CONTINUED FROM PAGE 11

coast event was inundated with at least twenty solutions,
ranging in price from a few hundred dollars right up to six-
figure packages.

Second to the flock of DAM sells was the broadside of
PDF workflow add-ons, led by Agfa with its Apogee system
and demonstrating an implementation of Adobe’s in-RIP
trapping technology using a Quark XTension that allows set-
ting sophisticated trapping settings which are read at the RIP
(download it from Agfa’s website if you're curious).

Among the handful of products which caught my atten-
tion, two stand out. First was the premiere of Ultimatte’s
Knockout 1.0 masking software, which blows away any
desktop masking package I've seen to date (www.ultimatte.com).
Second was Markzware’s soon-to-be-released prepress au-
tomation technology, MarkzScout, a cross-platform multi-
purpose file and workflow manager that may plug a vital
hole in the desktop workflow.

-

In the end, the most significant product showing at Sey-
bold had to be what was obviously a last minute addition to
Steve Jobs” keynote. Jobs provided a spellbinding demon-
stration of Adobe’s “Quark-killer” page layout software
(known only as K2 — pressroom scuttlebutt had it that
Adobe folks were slightly miffed because he wasn’t actually
supposed to call it by name).

Although K2 is still in early development and not expect-
ed to be seen before the second half of next year, from this
sneak preview it appears that all the rumours of it being a
QuarkXPress-cam-Photoshop are true. We saw an impressive
display of object-oriented programming that allows free ma-
nipulation of both graphics and editable text (including
shearing and skewing) incorporates layers, supports a PDF
workflow seamlessly, and promises creative imaging and
vector-based tools far beyond anything Quark has ever
shown. No wonder Tim Gill is scared.

It’s a good bet that if it hadn’t been for the pressure John
Warnock and Chuck Geschke were getting from sharehold-
ers and customers over the Quark attack, Adobe would
have had no compelling reason to preview K2 at Seybold.
But there’s no question it had its desired effect. The crowd
was wowed, the trade press was rapturous, and the Quark
offensive was for all intents and purposes stopped dead in
its tracks right there and then.

Adobe is also driving a major initiative to publicize its
Extreme architecture, the “son of Supra” PDF workflow and
RIP system which has been repackaged with a heavier em-
phasis on Adobe’s Portable Job Ticket capabilities. By about
this time next year, we should see more evidence of how
well Extreme is being adopted by OEMs.

sk
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boundless. She has definite ideas about what works and

Ojai Digital Arts Center

CONTINUED FROM PAGE 14

what doesn’t.

“Part of the skill of teaching is in balancing the needs of
a wide spectrum of students,” she says. “One of the added
difficulties with web design is that there are so few qualified
instructors.”

The Ojai Digital Arts Center truly boasts state-of-the-art
technology. Aside from the twenty brand new 233 MHz
iMacs (each loaded to the gills with RAM, equipped with
Virtual PC to emulate the Wintel environment, and connect-
ed by a 100BaseT Ethernet network), it happened that by a
stroke of good fortune, the space that Lynda and Bruce
chose was situated below the only T1 line in Ojai — a bless-
ing neither of them had anticipated. So not only do students
at Ojai benefit from the tutelage of a leading figure in web
design, using the latest in hardware and software, they also
enjoy very fast connectivity to the web.

Tutoring doesn’t end with scheduled classes; the facility
remains open in the evening so that students can spend
time on their own, practicing what they learn and exploring
individual needs.

The structure of Lynda’s classes is an equal mix of lec-
tures and hands-on discovery. She and Bruce split lecturing
chores, though Lynda handles the lion’s share. The maxi-
mum class size at ODAC is twenty students.

The Ojai Digital Arts Center’s five day course in web de-
sign costs $1295 (US); a three-day course is also available at
a cost of $895 (US). Check out the complete details at
www.digitalarts.com. []

With random thoughts of technological convergence
drifting through my head, T tottered down the stairs of The
Stinking Rose restaurant, the beneficiary of an excellent gar-
lic-strewn dinner courtesy of color king Michael Kieran.
Spotting a cab and two people getting into it, I soon found
myself riding back to my hotel with Hewlett Packard color
guru Michael Stokes and Roger Siminoff, Apple’s worldwide
ColorSync developer liaison.

Being in a curious frame of mind, and with fresh memo-
ries of struggling with Photoshop 5’s new color management
setup, I asked these proponents of sSRGB, Photoshop’s de-
fault color space in which a vast chunk of the CMYK gamut
is missing, what place this color space had in a world still
very much dependent on printed matter.

Our brief but lively exchange concluded with Siminoff’s
declaration, “It's not meant for a print-centric workflow!”

It got me wondering about how useful the “Digital Mas-
ter” would ever be if in the quest for a universal color stan-
dard, print is relegated to non-essential status. Maybe full
convergence in the workflow is farther off than I thought. []
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Fireworks, Flash and Dreamweaver
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DREAMWEAVER 1.2

Recommended system requirements
Windows 95 or NT version 3.0,

16 MB RAM

Power Macintosh, System 7.5,

24 MB RAM

Retail price $470

Macromedia Web Essentials (Dream-
weaver plus Fireworks) $399 (US)
Contact Macromedia 800-457-1774

ANIMATION IN DREAMWEAVER
Dreamweaver’s Timeline inspector en-

ables the creation of animation without

using ActiveX controls, plug-ins or Java

applets. Timelines use DHTML features

to change the position, size, visibility

and stacking order of layers in a series
of frames over time.Timelines can also
change the source file of an image that

is not in a layer and can execute behav-

iours at a particular frame. But they
work only in 4.0 or later browsers.

Dreamweaver’s Timeline inspector enables the
creation of animation using DHTML features.

But you may find your-
self using external editors
less: Dreamweaver’s in-
ternal editor has been up-
graded with color-coded
HTML.

You can add database
functionality to Dream-
weaver 1.2 by using Cold
Fusion objects (available
from Macromedia) in
conjunction with Allaire’s
Cold Fusion Application
Server.

Mac-based CyberStu-
dio can show how a Mac
layout will look on a Win-
dows system. It would be
nice if Dreamweaver pro-
vided a similar reciprocal
function for its Windows
and Macintosh users.

Dreamweaver 1.2 is
notably more stable than
Version 1.0; 1.2 updates
can be downloaded free
from www.macromedia.com.

FIREWORKS

Made with extensive
input from Web design-
ers, Fireworks  purpose is
to create optimized GIF,
animated GIF, and JPEG
graphics in the fewest
number of steps. It pro-
vides Web specific fea-
tures such as image slic-
ing, and automatic code
generation for HTML ta-
bles and JavaScript
rollovers. It's somewhat
comparable to Adobe Im-

ageReady, a bitmap-based application, but Fireworks func-
tions in both vector and bitmap modes, with vector mode as

its default.

Fireworks interface, with its floating tabbed panels, feels
like Photoshop. An Opacity toolbar lets you set opacity using

side URL hotspots to
objects, by drawing
color overlays on
your graphic. On
Macs, this toolbar
also provides status
information for select-
ed objects, including
a ‘stop bitmap mode’
button. On Windows,
status info is located
in the lower left cor-
ner of the document
window.

Fireworks’ vector
tools produce ed-
itable results, like
Freeband's and Illus-
trator’s tools, though

EXTERNAL IMAGE EDITORS

You can open a selected image in an
external image editor directly from
Dreamweaver by first specifying an
editor, like Fireworks or Photoshop in
Dreamweaver's preferences. Not
surprisingly, Fireworks has a built-in
edge here: Fireworks automatically
searches for the original PNG ver-
sion of the selected file, since PNG
is its native file format.

Other image editing applications
open the selected image.To open
the original file from which your
GIF was generated you have to pro-
ceed manually, and then regenerate
the GIF. In either case, when you re-
turn to Dreamweaver after saving
the image file, it’s already updated in
the Document window.

they often behave like bitmap tools; the bitmap tools gener-
ally behave like Photoshop tools. So dual-mode tools, like
the Brush, are editable in one mode, but not the other. You
have to familiarize yourself with idiosyncrasies introduced to
accommodate the dual interface. For instance, bitmaps re-
side within vectors, so importing and placing images is a

vector function, and
likewise the Crop tool
works only in vector
mode. ImageReady is
a direct descendent of
Photoshop. Fireworks,
which is part unique,
and part Freeband,
Photoshop and Flash,
has a steeper learning
curve,

In this application,
you can select an air-
brush swoosh with
one simple click, then
change its path, color
and texture using
simple menu selec-
tions; or turn a 1-pix-
el hard pencil path
into a 20-pixel oil
splatter and then con-
vert its soft drop
shadow into a halo
glow. It's uncanny.

A floating palette
provides Brush and

FIREWORKS AND
IMAGEREADY

Procedure-wise, the fundamental
difference between ImageReady and
Fireworks is this: with ImageReady,
you mostly import images or con-
vert vector graphics by using the
File > Open command. ImageReady’s
display window provides two sepa-
rable tabs, one with the original im-
age, the other with a copy for opti-
mizing. ImageReady doesn’t separate
image editing and export functions.
With Fireworks, you can open a
bitmap directly, placing it into the
background layer of your file, or im-
port vector and bitmap graphics
into any other layer of an existing
file,as in a page layout application.
You work with a Fireworks-native
PNG file,and can switch between
vector and bitmap modes as need-
ed.When finished, you access an
Export Preview dialogue. Here, you
optimize your graphic for export
using comparative previews, then
create an export file. Unlike flat-
tened export graphics, the master
PNG file is always editable, since it
retains all path, frame and layer in-
formation.

sliders and choose Photoshop-type blending modes. The
URLs toolbar enables you to attach client-side and/or server
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Fill tabs with exten-

sive gradient options and modifiers. And here’s a neat
touch: sample swatches pop up as you move through tex-
ture selections. An Effects tab provides bevel (inner and out-
er), drop shadow (basic and soft), emboss and glow op-
tions. And by grouping objects and effects, you can pile on
even more effects.

Fireworks has pretty comprehensive drawing functions,
including grouping, layering and masking, plus a customiz-
able grid and guides. But like ImageReady, Fireworks lacks
image editing tools such as Smudge, Blur, Sharpen, Dodge,
Burn and Sponge. (There are Blur and Sharpen filters.) It
does, however, have an extended set of path altering tools,
including: Redraw for altering part of a path, Freehand-type
Freeform tools for pushing and pulling path segments and
Path Scrubbers for altering the speed and pressure-based
characteristics of ‘bitmap’ paths. When you click an initial
point and then drag, the Pen tool displays a rubber-banding
curve that shows your impending shape. And an Export
Area tool enables you to re-use a graphic by exporting only
selected portions. You use layers less than in Photoshop or
ImageReady, since elements don’t automatically merge. I
particularly like one tool option: selectable objects can be
highlighted as your mouse passes over the artwork.

You input text into Fireworks with an intermediary Pho-
toshop-like Text Editor. You can adjust tracking, leading,
kerning, proportions, alignment, direction, flow and base-
line shift, but the palette displays only font selection and
size. You can apply and preview text without closing the
editor, but unlike other palettes there’s no auto-apply. A ma-
jor plus that ImageReady lacks, is Fireworks ability to apply
multiple formatting attributes within text blocks (but not
multiple colors). Also, Fireworks produces manipulable text
boxes — you can rotate, skew and stretch them along with
their content. And if you re-size just the box, Fireworks
auto-wraps copy. Single lines of text or entire paragraphs
can be attached to paths. But since type is not selectable, as
in Hlustrator or Freeband, re-positioning requires inputting
text offsets within a dialog.

Fireworks outdoes ImageReady in its support for roll-
overs. You simply make an original button in one frame and
the version that appears when a cursor passes over it in the
next frame, using the layers-style Frame panel.

You don’t even have to create the look of succeeding
states — just apply presets from the Effects palette: raised,
inset, highlighted and inverted. In Fireworks” Export Preview
panel, you apply options and optimize — Fireworks creates
a separate GIF file for each rollover state and creates an
HTML file containing the Javascript code (including pre-
caching) all in one go.

Fireworks imports Photoshop 3 and 4, GIF, JPEG, PICT,
PNG, TIFF, xRes LRG, BMP and ASCII files. Besides Fire-
works’ bitmap tools, these files can be edited with Photo-
shop filters, plus some third-party plug-ins. And you can

R E VI E W S

I silmms B (left) The Brushes and Fills
il |l 1L palette. The Effects tab has
bevel, drop shadow, emboss
and glow options. It also
provides button state presets:
raised, inset, highlighted and
inverted.
(right) The Layers and Frames
palette, for managing multi-
layered documents and
animation

configure your Prefs to access your Photoshop folder. Fire-
works doesn’t load known unusable plug-ins. On my Mac
G3, Extensis products ended up on the disabled list. Eye
Candy 3.01 filters worked. But KPT 3.0 filters, which were
accepted, crashed the entire system. Fireworks imports vec-
tor graphics from Hlustrator 7, Freeband 7 and 8 and Corel-
DRAW, with layers intact. Imported paths are editable.

Most of us use Photoshop (via plug-ins) for scanning and
then correcting images, or just fixing existing images, by ad-
justing levels, curves, color balance, brightness, contrast,
hue and saturation. Though Fireworks and ImageReady are
primarily made for Web optimization, users expected image
correction capabilities in these applications when they pre-
miered. Fireworks pales next to ImageReady here. Im-
ageReady provides some of the above, plus a Windows to
Mac/Mac to Windows gamma function. Fireworks can open
Photoshop files with layers, but can’t edit them. With Im-
ageReady, if your images don’t need intensive editing, you
can simply access your Pho-
toshop scanner plug-in, and
then scan them directly into
ImageReady.

Being vector-based, Fire-
works can’t do likewise. Its
Xtras menu provides non-re-
versible Photoshop-type ef-
fects like Blur (including
Gaussian Blur), Invert and
Sharpen (including Unsharp
Mask) — compensating
somewhat for its shortfall

here. FIREWORKS 1.0

The current version of )
Recommended system require-

ments
abilities by including an un- EVVINSCENE A0\

Fireworks supplements these

documented set of Cytopia Windows NT 4 (with Service Pack

PhotoOptics filters in its drop- [EEISEIMERTA
Power Macintosh, System 7.5.5,

24 MB RAM (32MB with virtual
memory off)

down Xtras menu. The set
has eight photographic color
manipulation filters for col-

Retail price $460
$199 (US) if you own Dreamweaver

orization, contrast, exposure

and color cast treatment, or a competing product, contact

along with special effects VISP ER b2
such as noise generation and
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(above) Fireworks’ Export Preview dialogue. Options, o
File and Animation panels let you experiment with file =
formats; compare the the output of color palettes and R
transparencies; and customize and save palettes, . pimmr
export presets and animation settings.
(right) The Slice tool in the URLs toolbar (grayed -
out).You simply draw a rectangle on the graphic, then i - L

define settings in the Object Properties dialogue.
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infrared simulation. On-
EXPORTING FIREWORKS

FILES

The Export Preview dialogue is
where Fireworks really shines, en-
abling users to optimize for quality
and speed using four side-by-side
export previews — and opening up
the potential for finding unanticipat-
ed or innovative solutions. Options,
File and Animation panels let you
experiment with file formats; com-
pare the the output of color

screen help is provided with-
in  PhotoOptics’ floating
palettes, but for detailed
info, you have to go to
www.cytopia.com. The PhotoOp-
tics dialogues use annoyingly
small thumbnail previews
and controls, but they’ll do if
you don’t have Photoshop.
Fireworks’ File > Batch

Object Properties dialogue,
where you define the slice as
an image or rollover, select
export settings, or access the
Export Preview. Repeat for
each slice. Then use the File
> Export Slices command to
put your images into a sub-
folder. Fireworks automati-
cally generates an HTML

ANIMATION IN FIREWORKS

Fireworks streamlines the genera-
tion of animated GIFs using tween-
ing. This is done with symbols and
instances, a method derived from
Macromedia Director’s cast mem-
bers and sprites; and also inherited
by Flash. Fireworks’ approach is
consistent with the other apps, but
more complex than Imageready’s.
And its frames can’t be displayed
side-by-side.

But with its layer-to-frame quick
navigation and frame-to-frame copy
abilities, and the capability to tween
shape, color and fills as well as
movement and opacity, Fireworks en-
ables greater sophistication. Sym-
bols are original objects; instances
are representations of the original
and update automatically when
symbols are modified. But modifica-
tions to an instance do not affect its
symbol.And changes to an instance
are automatically reapplied when its
symbol is modified.

To see how your animation plays,
you go into the Export Preview dia-
log, which provides a tabbed Anima-
tion palette for inputting specifics
like frame delay and number of
loops.

table file, with links to the images.

palettes and transparencies (Index
Color,Alpha Channel); and cus-
tomize and save palettes, export
presets and animation settings.

Each preview includes estimates of
file size and download time at 28.8
kps, plus a pull-down menu of ex-
port presets. Selected palettes dis-
play on the Options panel and re-
configure as you reduce them — by
placing your cursor on a swatch,
you can determine its RGB, Hexa-
decimal and Index values.

Instead of going directly to the
Export dialogue, you can automate
the export process by selecting the
Export Wizard from the File menu.
The Wizard analyzes and prepares
the file based on your input regard-
ing intended use. It then opens the
Export Preview dialog box with one
or more optimum formats in place.
Fireworks exports GIF, Animated
GIF, GIF Rollover, JPEG, JPEG
Rollover, PNG, TIFF, xRes LRG, BMP
and PICT.

command converts an entire
folder of graphics using any
setting made in the Export
Preview dialog. And with it
you can generate sets of
thumbnails in one go. There
are  no  Photoshop/Im-
ageReady-type actions for
grouping pre-export com-
mands.

Fireworks image slicing
and exporting capabilities
surpass Imageready’s. You
can slice anywhere, and the
pieces are exported as
unique files. They can be in-
dividually optimized and
coded as links; you can mix
JPEGs and GIFs; and the
pieces appear as a seamless
whole on the Web page. You
simply draw a rectangle on
the graphic; this calls up an
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If you've edited a PNG file that was launched from with-
in Dreamweaver, just choose File > Export Again, type a file
name in the resulting dialog, select a destination folder and
then click Save. The image updates in Dreamweaver.

FLASH 3

If Fireworks is Freehand for the Web, then Flash is Di-
rector for the Web — a means to create and deliver fast,
compact vector-based graphics, animation and interactivity.

Initially, the Flash player needed to be installed by the
end user. Now, the Shockwave Flash Player is included in
every Netscape browser and comes pre-installed in the Win-
dows 98 operating system; America Online is also adding it
to the AOL 4.0 CD-ROM. With these alliances, the release of
Flash 3, and the recent opening of the Flash file format
(.swf), Macromedia seems to have gone from mere viability
to establishing a vector graphics standard for the Web.

Two work areas ‘cohabit’ the interface: the Stage, where
you create and view the individual frames of the Flash
movie using shapes, groups and symbols; and the Timeline,
where you define the movie over time. Timeline rows corre-
spond to layers. Scenes incorporate layers. And scene names
are used as targets for actions. Binder-like Scene tabs are

displayed down the right side of the Timeline window

As in Fireworks, symbols are reusable movie elements.
Flash symbols can include other symbols, shapes, groups
and text; and incorporate animations and interactions. Each
symbol is stored as vector data, so you can use as many in-
stances of a symbol as you want without increasing the
movie’s file size. (Director users: cast member = symbol,
sprite = instance, Score = Timeline.)

In Flash 3, three types of behaviours are assigned to
symbols and instances: Graphic, Button or Movie Clip. A
graphic symbol is mostly used for still images or animations
you want controlled by the main Timeline. A movie clip is
similar to a graphic symbol, but works as a completely func-
tional, interactive and self-contained movie that plays inde-
pendently of the main movie’s Timeline. A button symbol
has a four frame Timeline that defines the mouse-up,
mouse-over, mouse-down and hit states of the button.

Fireworks doesn’t store symbols, they’re just tagged.
Flash uses libraries to manage three element types: symbols,
bitmaps and sounds. Besides placing new instances on the
Stage, Flash libraries enable you to edit existing symbols or
check how elements play.

You can now make more things happen, in more com-
plex ways, when a user clicks a button or a movie reaches a
certain frame. Flash 3 has new actions for stopping and
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(top) Flash’s toolbar, with the Arrow tool and modifiers selected; the
Timeline, where you define the movie over time; the Stage, for
creating and viewing the individual movie frames; and the Library, for
managing symbols, bitmaps and sounds

(bottom) The Instance Properties dialogue, with the Actions tab
selected.
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starting movies, loading and unloading movies, or going to
a specified URL. ‘If Frame is Loaded’ verifies that the con-
tents of the specified frame are present before executing an
action. ‘Tell Target’ accesses different levels in Flash’s time-
line hierarchy, enabling one object to control the actions of
another object. The new Actions panel, residing in the In-
stance and Frame Properties dialogues, lets you assign mul-
tiple actions to a single button or frame event.

You can now give each frame a unique name. Unlike a
numbered frame, a labelled frame keeps its identifier if you
add or remove other frames from the movie — so you don't
have to revise its links if a labelled frame shifts.

Because shape tweening transforms shapes without
keyframing each change, it's memory efficient. In Flash 3,
you can attach corresponding shape hints, like pasties, onto
your start and end
graphics to visually

optimize the transi- FLASH AND FIREWORKS

DRAWING ENVIRONMENTS

Though Flash is vector-based, its
) drawing environment differs ap-
example, using a preciably from Fireworks’. Freehand
shape hint to mark is more the predecessor of Fire-
each eye keeps the works, while Flash’s Stage derives
eyes recognizable more from Director’s Paint Win-

dow. Fireworks' interface is orient-
ed to its dual vector/bitmap envi-
ronment, but Flash’s drawing me-
thods have more to do with
animator’s needs and the tight in-
terplay between Stage and Time-
line.

tion. So if you’re
tweening a face, for

during the transition.
By applying new
alpha channel effects
to colors and gradi-
ents, you can control
the opacity of just

about anything you
draw in Flash 3. By
adjusting the trans-
parency of symbols
and groups and then
tweening, symbols
can be made to fade
in or fade out. And
for a more dramatic
effect, you can
tween both alpha
settings and shapes
so both happen si-
multaneously.
Similar to Photo-
shop's layer masks,
Flash's new masking
layers let you use
shapes or text objects
on one layer to selec-
tively reveal parts of
the layer underneath.
In a drawing applica-

graphic exchange »october/november 1998 > 5I

FLASH AND DREAMWEAVER

If you're using Dreamweaver, its
easier to forego Aftershock. In
Dreamweaver, place the cursor
where you want to insert the
Shockwave movie. Click the
Shockwave Flash button on the
Object palette. Enter the name of
the source movie file in the dialog
box that appears. In the Property
inspector, enter the width and
height of the movie in the W and
H boxes. These are the only re-
quired properties. If you don’t
want to go with Dreamweaver’s
defaults, the Property inspector
provides pop-ups, check boxes,
text fields and buttons for setting
all the Flash parameters.‘Tag’ de-
termines the tags (OBJECT
and/or EMBED) used to identify
the Shockwave movie.‘ID’ defines
the optional ActiveX ID parame-
ter.‘Parameters’ opens a dialog
box for entering additional para-
meters. ‘Quality’, ‘Scale’, Autoplay’
and ‘Loop’ are self-explanatory.
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The Bandwidth Profiler checks |* . - —the—rn, = = = = 'E"_ functions work only when
the contents of every frame in a S exported. Using the Control
movie, compares them to the = e
modem speed you specify, and v i menu, you can export a

graphically indicates where the
downloading might fall behind. S—

tion, this would be like using

the Paste Inside command;

movie in Shockwave Flash
format and run it in a test
window. You can also rapid-
ly track down potential
download problems using
the new Bandwidth Profiler.
It checks the contents of

in Flash animation, it enables

every frame in a movie,

keyhole or spotlight effects
and transitions.

Flash provides ten standard-looking drawing tools, aug-
mented with contextual modifiers in the toolbar. In Free-
hand or Ilustrator, some of Flash’'s modifiers would be con-
sidered standalone tools. For instance, the Arrow tool modi-
fiers are Rotate, Scale, Snap, Smooth and Straighten.

You get used to Flash’s drawing environment pretty fast,
considering that certain drawing conventions don’t apply:
you don’t always select elements before modifying them; a
filled shape with an outline is two separable elements; you
just click, rather than shift-click, to add to a selection;
groups are floating elements; ungrouped elements merge;
you just grab and pull to reshape elements (there are no

bezier handles).

Certain tools and modifiers facilitate illustration: the Ink

Bottle tool changes the color, thickness and style of existing

lines; Straighten and Smooth modifiers clean up freehand

macromecis
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FLASH 3.0

Recommended system requirements
Windows 95,24 MB RAM
Windows NT 4,32 MB RAM
Power Macintosh, System 7.5,

32 MB RAM

Retail price
$460

Upgrade
$99 (US)

lines; Brush modifiers allow
you to paint inside or behind
and the Paint
Bucket enables you to fill
shapes that have broken out-

elements;

lines.

Flash now supports Fire-
works’ native format, PNG,
enabling cross-platform com-
patibility for importing and
exporting bitmapped images
with alpha channels. You
can directly import Freehand
8 files, with CMYK-to-RGB fi-
delity and layers. llustrator
7 files have to be pasted
from the clipboard. Flash
also supports: GIF, animated
GIF, JPEG, PICT, PNG, Auto-
CAD DXEF, Enhanced Metafile
and FutureSplash Player, plus
AIFF and WAV sound files.

Although  Flash plays
some

movies internally,
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compares them to the mo-
dem speed you specify, and graphically indicates where the
downloading might fall behind.

Flash 3 can create templates for use with Flash Genera-
tor, a Web server application that dynamically adds data to
Flash movies, like real-time headlines, advertising, interac-
tive maps, schedules, graphs, and personalized user inter-
faces. Generator is available directly from Macromedia.

Flash 3 ships with Aftershock, a separate application for
automatically generating HTML files that contain Shockwave
Flash movies. Aftershock inserts Flash movies into an HTML
document using the EMBED and OBJECT tags, insuring
compatibility with both Explorer and Netscape.

Flash 3 also ships with the stand-alone Flash player, that
enables you to create projectors: Flash movies that play all
by themselves. You just export a movie as Shockwave Flash
file, double-click the file to open it in the stand-alone player
and choose File > Create Projector. Done.

CONCLUSION

Dreamweaver and Fireworks are a formidable integrated
pair. Dreamweaver, with its unique roundtrip HTML, is one
of the best pro-oriented Web site applications out there. And
Fireworks has strong enough vector tools that you really don't
need Freehand or Illustrator, except in extraordinary circum-
stances.

But you should keep Photoshop in the production stream
for scanning, correction and intensive image editing. Be-
cause you can access Fireworks PNG files directly from
within Dreamweaver, it makes sense to import your Photo-
shop files into Fireworks and then use PNG files as masters.

If animated GIFs and DHTML will take care of your ani-
mation and interactivity needs, then you're all set with
Dreamweaver and Fireworks. If not, then Flash will boost
your capabilities here considerably. Dreamweaver's DHTML
comes with browser compatibility issues. But ironically,
Flash’s downside, the fact that it is only viewable with a
plug-in, is also an advantage — all users with a version 3
browser or better, pretty well see the same thing. Note that
Flash is the most difficult of these applications to master.
Dreamweaver and Fireworks provide your site’s indispensi-
ble elements. Flash makes it sing. [



